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Chapter 1
About Elixir Report Designer

Enterprise Reporting for Web, Print and Mobile
Delivery

Amidst fast-changing business environment, corporate enterprises need timely and accurate visibility
into business operations. Actionable information must be presented and delivered to the right targets
in the right forms. Designed for power and ease of use, Elixir Report Designer brings unmatched price-
performance to meet your enterprise wide reporting requirements.

Sporting a new-generation End-to-End Integrated Business Intelligence Architecture, Elixir Report
Designer comes built-in with a data aggregation and transformation engine to enable complex data
processing including OLAP Cube transformation. With newly enhanced advanced internationalization
support, Elixir Report Designer pushes the envelope for multi-lingual support to enable enterprises
tapping into the increasingly globalized markets. Numerous innovative report layout controls deliver
unsurpassed power to report developers, while keeping ease of use and maintenance in balance. Complex
layout requirement is no more a problem with advanced features for templates spanning across multiple
pages, or with multiple report sections with respective header and footer control, auto-resizable
horizontal and vertical boxes, user-definable style support for CSS Level 3 - complete with the full
range of exotic border styles such as Groove, Inset, and Wave, as well as an all-encompassing dynamic
watermark control which can include just about anything a report can render.

As an integral part of Elixir's integrated Business Intelligence suite covering the full information
lifecycle from ETL, OLAP, to Dashboard, Elixir Report Designer is the new choice for Enterprise
Reporting for Web, Print and Mobile Delivery, a fundamental building block for enabling the
Information Enterprise.

Look and Feel of Repertoire Designer
The look and feel of Repertoire Designer can be edited by user by changing it in Global
Properties then Look and Feel tab. In order to have the Look and Feel tab appear in
Global Properties, substance-lite.jar and substance-theme-pack.jar must be placed in /Reper-
toire/ext. Only then, the user will be able to change the look and feel of Repertoire Designer using the
list of options available.

Features of Report
Multiple DataSources: Multiple DataSources can be used in the same report or can be shared among
various reports. The various data source types are JDBC, JDBC (JNDI), LDAP, XML, Text, Java
Object. Through ODBC you can connect to a wide variety of databases such as Oracle, IBM, DB2,
etc.

Rich Set of Report Elements: Standard report elements include barcode, data field, images, labels,
etc. and Complex report elements include SVG, RTF, HTML and table components.
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Scripting and Parameterization: With a powerful JavaScript engine, pre-built functions like time
and date formatting, mathematical calculation, and other common operations. Reports can be
parameterized to generate dynamically based on values passed in at runtime.

Flexible Report Formatting: Create reports of virtually any type ranging from contact listing and
directory, sales reports, image-rich layouts and confidential documents with water marks.

Multiple Report Output Formats: The reports can be generated into various output formats like PDF
(with Access Security), HTML, XML, CSV, etc.

Internet: Elixir Report now supports the ability to view your report in the web page using an applet
and a Java plug-in through a web server.

SVG: Report provides support for HTML and SVG components for producing high- resolution image
output.

Mobile Support: Elixir Report Designer also enables integrated information delivery and reporting
of Java and XML applications to users of mobile devices, in particular users of wireless Java devices.
This is known as Elixir Report Mobile Edition. The ERME Designer component extends the Elixir
Report Designer to allow creation of report templates for reports on mobile devices.

Report Security
At the last page of the Report Properties Wizard, the user can set security options, as seen in Figure 1.1,
“Set Security Options”.

Figure 1.1. Set Security Options

• Read-Only: When selected and saved, the next time a user opens this report, the user will not be
able to edit any details of the report template like name and scripts of the report template.

• Hide Details: When this option is selected and saved, the next time when this report is opened, the
user will only be able to see the name of the report.

• Encrypted: This option is to be used with either Read-Only option or Hide Details option
or both. Checking the checkbox will prompt the user to enter a password, then re-enter to confirm
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the password. (Both passwords must be the same) After this is done, if another user would like to
edit any selections, he will need to enter the password.

Working Set
Users can define a Working Set whereby only the selected filesystems will be displayed in Elixir
Repository.

This is done by clicking on the Global Properties button on the Action Bar. Select the
Repository tab, as shown in Figure 1.2, “Global Properties - Repository”. Click on the Add button
to add a working set. The Working Set Wizard will appear as shown in Figure 1.3, “Working Set
Wizard” and allow the user to enter the name of working set and to select the filesystems to add to the
working set. After that, click on Ok, then select the desired working set from the drop-down list.

Figure 1.2. Global Properties - Repository
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Figure 1.3. Working Set Wizard

Hidden Files And Folders
To set files or folders to hidden in a local filesystem, user will need to go to the directory where the
file or folder is placed through Windows Explorer. Right-click on the file or folder and select
Properties. Check the property that says Hidden. Click on Apply then Ok.

Refresh the filesystem in the repository. The file or folder that has the hidden property applied will no
longer appear in the repository.

4
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Chapter 2
Report Designer Workspace

Adding a Report Template
The common elements in the Elixir Workspace are discussed in the Elixir Repertoire user manual,
which shows how to add filesystems and files. This chapter will discuss the Elixir Report Designer
features that build on the workspace.

Each FileSystem has a pop up menu. On selecting the Add -> Report Template, the "Report Wizard"
appears as shown in Figure 2.1, “Add Report”. Enter the name and description of the Report Template
in the text box and click the Next button. Alternatively, by clicking the New File button [icon] on top
of the Elixir Repository panel you can select Report Template from the Add File dialog. This is followed
by selecting the location for the Report Template, then click on the Finish button.

Figure 2.1. Add Report

Choose a DataSource from the repository as shown in Figure 2.2, “Choose DataSource”. If the selected
data source contains parameters that need to be propagated to the report then select "Propagate
datasource parameters to report" check box. Otherwise you should provide values for any dynamic
parameters here. For more information on the parameters and their propagation refer to Chapter 3,
Report Structure and Invocation.
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Figure 2.2. Choose DataSource

On the next screen, select the Report Type from the list of report types as shown in Figure 2.3, “Choose
Report Type”.

Figure 2.3. Choose Report Type

There are wizard pages to guide you in creating three types of reports: Blank, Standard and Mobile.

Blank Report
On selecting the Blank Report and clicking the Finish button a blank report is added to the window.
All report components must be added manually.
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Standard Report
The three types of Standard Reports are Tabular, Columnar Report and Mailing Labels as shown in
Figure 2.4, “Standard Reports”.

Figure 2.4. Standard Reports

Tabular Report

If you want to add a report in the form of table then select the Tabular Report from the standard report
types that are listed. Click the Next button.

The fields in the data source are listed so that you can choose the ones you want to add to the report.
Here's an example of a tabular report generated with four columns:Figure 2.5, “Generated Tabular
Report”.

Figure 2.5. Generated Tabular Report

You can now improve the report by adding colours, logos and additional information to meet your
requirements.

Columnar Report

A Columnar Report allows elements to be grouped. The creation steps are similar to the creation of a
Tabular Report, except in addition you need to specify the fields to be grouped, and optionally any
sorting. You are provided with some choices for the report layout:
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• Stepped: Stepped layout is the default and the most commonly required layout for the majority of
reports. In stepped layout the grouped fields are arranged in indented steps and the rest of the fields
are arranged in sequence.

• Block: A block report displays data that has been grouped or sorted in vertical columns.

• Align Left: In this type of layout all the data are aligned to the left of the table. The grouped columns
are displayed one below the other and the sorted columns are arranged vertically as in a table.

• Outline: It is similar to the stepped report except that there is outlining and highlighting of the
group sections.

A sample stepped columnar report is shown in Figure 2.6, “Generated Columnar Report”.

Figure 2.6. Generated Columnar Report

You can now improve the report by adding colours, logos and additional information to meet your
requirements.

Mailing Labels

If you want to add a report in the form of a Mailing Labels then select "Mailing Labels" from the list
of Report types. Click the Next button. The fields in the data source are listed as shown in Figure 2.7,
“Select Fields”. Select the field that has to be included in the report and click on the '>' button. If all
the fields have to appear in the report then click the '>>' button. After selecting the fields to be added
in the report, click the Next button.
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Figure 2.7. Select Fields

The screen appears with three tabbed panes. They are the Label, Page and Preview. Checking on
Custom Label will enable the user to customize the Mailing Label based on individual's needs. If
not, the fields in the respective tabs will not be editable.

The label settings are displayed in the Label tab shown in Figure 2.8, “Label Settings”. The available
options under Label tab is given below:

• Label Width: Width of label

• Label Height: Height of label

• Horizontal Gap: Amount of space between each label horizontally

• Vertical Gap: Amount of space between each label vertically

• Left Padding: Amount of space on the left of Mailing Label from the page margin

• Top Padding: Amount of space at the top of Mailing Label from the page margin
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Figure 2.8. Label Settings

Setting the size of the page and page margin are done in the Page tab. If the list of Paper Size is not
enough to satisfy, user can specify their own dimensions to customize their template.

User can make use of the Preview tab to preview the template before creating the template. To
complete the template creation process, click on the Finish button.

Case Study
Before creating a Report Template you should initially add a data source say, customer.ds to the
FileSystem. Refer to the JDBC chapter of the Elixir Data Designer Documentation for details on how
to add the JDBC data source Customer.ds.

If you want to add a simple tabular report follow the steps given below:

1. Select a FileSystem. Select Add->Report template from the file system popup menu.

2. When the Report Template Wizard appears, enter a name for the Report, First report, and
click the Next button.

3. In the screen that appears locate and select the Customer.ds DataSource and click the Next button.

4. Select Standard Report. The different types of Standard report are listed on the right of the dialog.
Select Tabular Report from the list and click on the Next button.

5. The next page allows you to choose the fields to show in the table. In this case, click the '>>'
button to move all the fields to the Report table.

6. Finally, on clicking the Finish button, First report.rml is added to the repository and opened to
show the Layout tab.

7. Select Render from the toolbar. On the Render Wizard select Glint and click the Finish button.
The output is displayed as shown in Figure 2.9, “Generated Glint Report”.
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Figure 2.9. Generated Glint Report
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Chapter 3
Report Structure and Invocation

Overview
In this chapter you will learn about the basic structure of reports and the different sections within it.
You will also get to know about the section invocation and how to control the render sequence.

Elixir Report Designer Workspace
The Designer workspace consists of three tabbed panes. They are Report tab, Layout tab and the
Functions tab.

The report structure, consisting of the DataSources, Page Setup, Sections and Style sections are displayed
in the left panel of the Report tab window. The Render Sequence and the Parameters panel are present
on the right of the Report tab window. These will be discussed later in this chapter.

The Layout tab window contains a tool bar and report layout as shown in Figure 3.1, “Report Layout”.
The layout contains a detail, headers and footers.
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Figure 3.1. Report Layout

The Functions tab window contains several tabbed panes: Script Summary, Function Definitions, On
Render Begin, On Render End and Render If. These will be described in Chapter 6, Scripting with
JavaScript.

Report Structure
In this section we will discuss the Report and Layout panels.
Figure 3.2. Report Tree

The Report tab includes a tree view of the structure of the report
template, the Render Sequence panel and the Parameter panel. The
structure of a report template is shown in Figure 3.2, “Report Tree”.
Each template consists of the DataSources, Page Setup, Sections
and Styles.

Report
The root item of the tree is the report itself. From the popup menu
you have access to the Report Properties (Figure 3.3, “Report
Properties”. Here you can change the report name, control settings
that apply across the report and control any RenderBegin and
RenderEnd scripts for the report as a whole. The RenderBegin script
will run before the first section is rendered. This means that it
happens before the render sequence is used and before any data is
loaded. Therefore you can control the render sequence programmat-
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ically from here. The RenderEnd script is run after all appropriate sections have been completely
rendered, allowing some clean up, if necessary.

Keep Page Count this property is enabled by default, allowing you to use page count substitutions
(i.e. ${##}) within your report. Page counting is expensive because the whole report needs to be kept
in memory until the page count is known, only then can the first page be output (presumably showing
the page count). If you don't need to show an overall page count you will get much better memory use
by turning this off. PDF output format is special, in that it allows page counts to be forward referenced,
so page counts will still work in PDF even with this option disabled. Therefore for optimal PDF output
(smallest memory use), you should disable this. In all other formats, you will get a value of 0 for page
count if this flag is not enabled.

Figure 3.3. Report Properties

Cache All Properties this property is enabled by default. When rendering a report, each component
has an explicit or implicit style associated with it. Searching for the appropriate property to apply
requires checking both the parent hierarchy and any style hierarchy. This is expensive to perform
repeatedly. If you know that the styles will not change while the report is being rendered, it is best to
cache the styles at the start. This means any subsequent scripted style changes won't be used. If you
are manipulating styles at runtime, using scripts, then set this value to false, to ensure the renderer
knows the styles are volatile and always identifies the correct style property.

Disable CSV AutoWrap this property controls the wrapping of text onto multiple lines. By default
text in fields is separated at word breaks and those words are moved to the next line when the field
width has been reached. This is usually not appropriate for CSV where there is no field width to consider
and the whole record is on one line. By selecting this option, long text that might wrap onto multiple
lines is all retained as a single line when rendering into CSV.

Disable Excel AutoWrap this property controls the wrapping of text onto multiple lines. By default
text in fields is separated at cell breaks and those cells are moved to the next line when the field width
has been reached. This is not always appropriate for Excel where there is no field width to consider
and the number of cells vary in each file. By selecting this option, long text that might wrap onto
multiple lines is all retained as a single line when rendering into Excel.
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Grid Enabled this property enables users to define a snap-to-grid for all components in the report
template. This allows for accurate placement and sizing of report components.

Grid Visible this property enables users to decide whether the grid dots will be visible in the report
template. To customize the appearance of grid, users can specify pixel values in the Grid X and Grid
Y fields.

Note

Once you have positioned your components, you can use the Lock property available for each
component on the property sheet. This will prevent the components being accidentally nudged.

DataSources
If a datasource was chosen from the Add Report Template wizard then a reference to it will be included
as the 'Default' DataSource. A datasource reference is a short name for a datasource file in the repository.
For example, the full path might be "repository:/Workspace/Samples/Employee.ds", but the reference
name can just be "Employee". A datasource reference also holds values for any dynamic parameters
that the datasource requires. You can add or modify the datasources that the report references using
the popup menus in the tree. A report can only use datasources that are listed here, and refers to them
by their reference name. Any number of data sources can be defined; each must have a reference name.
You can include the same datasource more than once (with different reference names), to allow
variations in dynamic parameters, or independent iteration through the records.

Each datasource may be accessed in one of two modes: Table mode or Streamed mode. There is a
checkbox on the DataSource wizard to control this. The default is Table mode. When operating in
Table mode, the records are loaded into memory so that they can be sorted and grouped and so that
you can query the total number of records etc. In Streamed mode, only a single record is loaded into
memory at one time, which greatly improves the memory efficiency, but prevents complex operations
that require access to more than one record. Streamed mode is best suited for billing operations etc.
where each customer record has no connection with prior or subsequent records. If you turn off Table
mode (therefore adopting Streamed mode) then any operations which depend on the presence of the
table, such as sorting, grouping and cross-record operations will fail.

There are two ways of opening a datasource when a report template is already opened. First, in the
Data|Shapes|Styles tree panel, right-click on the datasource then select Open DataSource. The
same procedure applies to the datasource(s) listed under the Report tab.

A DataSource reference can be copied using the popup menu and pasted into another report template.
It can also be pasted into the same report, to make a copy before modifying it.

Datasource(s) added in the Report Tree can do filtering of data without the use of Composite datasource.
However, this is only restricted to filtering. In order to do other processing, Composite datasource
must be used. To filter, right-click or double-click on the datasource listed in the Report Tree then
click Next, which leads to the page to add filter(s) to the datasource, as seen in Figure 3.4, “Add Filter
For DataSource”.

The other way of doing it will be through the Data tab on right of report layout. Right-click on the
datasource and select Edit DataSource..., then the Next button. The page will be identical to
the one seen in Figure 3.4, “Add Filter For DataSource”.
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Figure 3.4. Add Filter For DataSource

Page Setup
When a Report Template is created, a 'Default' Page Setup will be added under the Page Setup section
of the tree. Each section of the report can have it's own page setup, or several can share the same one.
This allows reports to combine landscape and portrait sections, or multi-column and single column
sections within the same report. Popup menus on the tree provide the usual abilities to add or modify
page setups. The Page Setup Wizard appears as shown in Figure 3.5, “Page Setup”.

The paper type is selected from the Paper combo box. The width and height of the paper type will be
automatically entered in the corresponding text boxes and the unit of measurement from the combo
boxes.

The page orientation, either Portrait or Landscape, can be selected by clicking on the corresponding
option button. The number of horizontal pages that the report will span have to be specified in the
Horizontal Pages field. The left, right, top and bottom margins are entered in the corresponding text
boxes and the unit of measurement from the combo box. You can set the unit of measurement you
want to use by default from the Global Properties button on the workspace toolbar.

The Column count is entered in the text box. Most reports are "Down Then Across", which means the
content flows down one column before proceeding to the next. Some templates, such as labels may
be need to be "Across Then Down" - each band of the report, e.g. each detail is laid out in subsequent
columns of the same row, returning to the first column of the next row when a row is complete.
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Figure 3.5. Page Setup

The Column Separation specifies the space between two columns. Similarly, the Row Separation
corresponds to the space between the rows of data.

A Page Setup can be copied using the popup menu and pasted into another report template. It can also
be pasted into the same report, to make a copy before modifying it.

Note

By default the measurement units of all the fields in the Page Setup is set to pixels. If desired
you can change the default measurement type. This can be done by clicking on the Global
Properties icon. The Global Properties Wizard appears. In the ERD tab, select the measurement
type from the Default Units combo box and click on the Ok button.

Sections
Every report template will have at least one section. A new section can be added using the popup menu
of the Sections node. The newly added section will be added to Render Sequence automatically.

The Sections Properties Wizard appears as shown in Figure 3.6, “Section Wizard”. It consists of four
tabs: Section, Group and Sort, Watermarks and Scripts.
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Figure 3.6. Section Wizard

Section

The name of the section is entered in the text box and the datasource is selected from the DataSource
combo box. A section can have no datasource, in which case it will still have a section header and
footer, but no details will be generated. This can be useful for special purpose sections, such as cover
pages or watermarks.

The "Keep blank pages" check box is selected if any blank pages produced during generation should
be preserved. Blank pages are usually the result of combinations of page breaks due to the way the
report is defined and should usually be discarded. Each section may contain a page header, section
header, section footer and page footer. A section header is shown before any details, starting on the
first page and a section footer is shown following any details.

By default each section after the first one will increment the page number as a continuation of the
previous section. If you need the page number to restart again at 1 then select the "Reset Page Count"
checkbox. This will break the report into logical page sequences which will each have individual
numbering and page totals. You can also begin a new page sequence within a section by adding an
explicit page break with a Reset Page Count option.

A Section can be copied using the popup menu and pasted into another report template. It can also be
pasted into the same report, to make a copy before modifying it. A report can have any number of
sections.

Within a section, you can refer to fields belonging to the section datasource by their field names. You
can also refer to fields belonging to other datasources, but you need to refer to them by their full name,
for example the field Salary in the datasource named Employee would be known as Salary if Employee
was the section datasource or as Employee:Salary otherwise. You can only refer to fields in datasources
that are referenced by the report template.

Watermark

A watermark can be a valuable addition to your report – whether you want to enhance the appearance
of the document by adding a seal or image or whether you want to add a text watermark that identifies
the report contents as a draft or confidential information, the watermark feature in report is a definite
asset for the users.
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A watermark may contain graphics and text that appears behind the main text of the report. It is usually
a lighter shade than the text, so you can read the report easily. Watermarks add visual attention and a
professional look with the use of imagery such as logos.

Watermarks are very flexible in Elixir Report Designer - a watermark is just another section, either
belonging to this template or a section from any other template in the repository, that is shown behind
the main information on page. This means anything you can do in a section can be done in a watermark.
A watermark can contain traditional text and images, but also data, charts, tables subreports etc.

When using a section as a watermark you need to consider it's data requirements. If the section has no
datasource, for example it is just an image or literal text, you can leave the datasource blank. Also, if
the section has a datasource then that source will be used by default, there's no need to redefine it here.
The only time you need to set the watermark datasource is if you need to supply a missing datasource
(the section needs one, but doesn't define one) or if you want to override the existing datasource.

Group and Sort

Grouping is done for categorization of data into various logical collections. Sorting is to arrange the
data in ascending/descending order.

In the Group and Sort tab there are four columns Name, Sort Order, Group On and Group Data and 5
buttons Add, Edit, Move Up, Move Down and Remove.

On clicking the Add button the Sort dialog appears. Select the name of the Field to be sorted from the
combo box. Select Ascending, Descending, Ascending(Simple) or Descending(Simple) Sort Order
from the combo box.

The difference between Sort (Ascending, Descending) and Sort(Simple) Order:

• Sort follows a proper dictionary sort algorithm whereby spaces are ignored. Sort(Simple) doesn't
follow the proper full sort definition, instead it treats every character as significant.

• Dictionary sort in the order of symbols first followed by alphabet, ignoring any spaces in-between
the words. Sort(simple) is in the order of spaces, symbols then alphabet.

• Sort(Simple) is especially useful when sorting data that contain any symbols, abbreviation, initials
and spaces. An example as shown in Figure 3.7, “Difference between Sort and Sort (Simple)”.
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Figure 3.7. Difference between Sort and Sort (Simple)

If your datasource is already sorted (e.g. as a result of an SQL "ORDER BY" clause), then you can
select None here. Select the Group On option from the combo box. If a range, substring, etc. is selected
as a Group On option then a text box appears where we can specify the value for that range or substring
based on which the grouping will be done. The Show Group Header and Show Group Footer check
boxes are selected if required. On clicking the Ok button after entering the values in the Sort dialog
they are assigned to the corresponding Name, Sort Order, Group On and Group Data columns in the
Wizard.

Scripts

There are three text fields for Render If, On Render Begin and On Render End functions. The JavaScript
functions that are entered in these text boxes are executed when the report section is rendered. For a
detailed explanation of the interactions of scripts when rendering refer to Chapter 6, Scripting with
JavaScript.

After setting the values in the tabbed panes and clicking the Finish button, the section is added under
the Sections node of the report template.

A Section can be copied using the popup menu and pasted into another report template. It can also be
pasted into the same report, to make a copy before modifying it.

Styles
Every Report template will have a set of styles. When a new Report template is added, the default style
settings will be included for the report elements in the Styles node.

The default style can be edited to suit your requirements. A new Style can be added by selecting Add
Style from the Styles popup menu. On selecting Add Style from the popup, a Wizard appears as shown
in Figure 3.8, “Style Wizard”.

20

Report Structure and Invocation



Figure 3.8. Style Wizard

The name of the Style is entered in the text box. Select the style to be included in the report from the
All Properties list box and click the '>' button. The style properties will be added to the Name column
and the property can be specified in the value column.

The Base combo box contains the list of styles that have been added to the report template. This is an
optional field. If you want to add a new style based on an existing style then select a Base style from
the combo box. The new style will inherit the style properties from the base style that has been selected.
That is the style properties of the Base style will be included along with the style properties that have
been set in the new style. So when the new style that extends the base style is selected for any particular
field the style properties of both the base style and the new style will be set for the field. On clicking
the Finish button after setting the properties the style will be added to the Styles section.

If you want to edit an existing style then select Edit Style from the popup menu of the Style. A style
can be copied from one report template's Styles section and pasted in the another report template Styles
section. It can also be pasted into the same report, to make a copy before modifying it.

The order of precedence in checking styles and their description are given below:

Explicit Named Style: An element placed in the report layout first checks if has a style associated
with it. If for instance a style has been defined in the master and sub report then the element placed in
the sub report first looks for the style name starting with that of the master report and then the sub
report. If there is a style with the similar name in the master report or the sub report then that style
applies to the fields. This is an explicit named style.
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Implicit Style: If there is no associated style then the element looks up whether there is any default
style for this kind of element i.e. if it is a literal field then it takes the "field-literal" style. See the RML
Raw Model document for the style names associated with each kind of component.

Inherited Style: The style associated with the parent of this element. If for example the detail has
some style associated with it then all the elements placed in the detail section will get that style.

Finally, if there is no match found, then it makes use of the global style which is fixed as black.

Some styles can be inherited from the parent, others cannot. The styles that can be (defined by CSS)
include FontName, FontColor, FontSize, FontBold, FontItalic FontUnderline and FontStrikethrough.

Render Sequence
Initially, when a report template is added to the repository it contains a default section. When a template
contains multiple sections, it is the Section Invocation table that controls the order of section rendering.
The initial configuration of the Section Invocation details shows the default section is enabled for
rendering.

If a new section is added to the report template and this section has to be rendered then click on the
New button on the Section Invocation panel. The Render Sequence Wizard appears as shown in
Figure 3.9, “Render Sequence”. The render sequence can include sections from both this report template
and other reports in the repository. Choose the report (if not the current report) and then select a section
name from the combo box. You can also choose to specify a datasource, which will override any
datasource defined with the section itself. This allows the same section to be used repeatedly in the
render process, with a different datasource each time.

Figure 3.9. Render Sequence

The Section Invocation details can be edited by double clicking on the column. The Render Sequence
Wizard appears in which the values can be altered. On clicking the Finish button the values in the
column will be edited.

If there is more than one row specified in the Render Sequence table, then the sequence in which the
sections are being rendered can be changed by selecting the column and clicking on the Up/Down
arrow button.
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Parameters
The Parameters panel is a table containing Name, Value and Enabled columns. The parameter name
and value are entered in the corresponding columns of the table. The Enabled column contains a check
box which can be selected to enable the parameter.

The parameters are used to control the way a report is rendered. The parameter can also be used to
control data like selecting a range of employees from a list of employees.

If the "Propagate data source parameters to report" check box is selected in the Choose DataSource
screen of the Report Wizard then any datasource parameters are added to the Parameters panel.

When the Propagate data source parameters to report check box is not selected in the Choose DataSource
screen of the Report Wizard while adding a report template then the parameter name and value can be
added later. Similarly if you switch over to another data source from the existing data source or add a
new data source that may contain parameters then you can add the parameter name and value to the
Parameters panel by clicking the New button.

The Parameter details that has been added to the Parameters panel can be edited or deleted by selecting
the row and clicking the corresponding button. You are allowed to have multiple parameters with the
same name, but only one can be enabled at a time. This allows you to store alternate sets of parameters
for different situations without having to re-enter the values.

Layout
The Layout tab was shown earlier in Figure 3.1, “Report Layout”. It contains the Navigation bar at
the top, the parts of report such as headers, footers, etc and the markers in the central panel, the toolbar
containing the report components on the left and the Data|Shapes|Styles tree panel and the Properties
panel on the right.

Navigation Bar

The Navigation Bar contains the Zoom and Section combo box. The Zoom combo box contains the
Zoom percentage. You can select the desired Zoom percentage from the combo box based on which
the Report parts will be Zoomed.

The Section Combo box contains the list of sections of the report template. You can select the section
for which the layout has to be modified.

The Redo button changes back the element to the previously changed stage and Undo button reverts
the element back to the state before the change.

The Render Report button is used to open the Render Wizard, as shown in Figure 3.10, “Render
Wizard”, to guide you through the report rendering process. Select an output type from the icons shown
and click Next to edit any custom properties of that output type. Alternatively, you can immediately
press Finish to use the default properties (or the values selected previously, if you are rendering the
same report again). The different output types are explained in detail in Chapter 5, Report Rendering
and Output Formats.
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Figure 3.10. Render Wizard

If you want to repeat a render with the same output type and parameters, you can choose the Repeat
Render button, which will by-pass the wizard.

Toolbar

The toolbar contains a set of elements that can be used for adding more features and elegance to the
reports. The description and properties of the report elements will be covered in the next chapter on
Report Elements.

Horizontal and Vertical Rulers

The horizontal and vertical rulers are used like a scale for page measurements. By default the width
of all the headers and footers in the reports layout remains the same.

The height of the headers and footers can be altered in a report. The vertical rulers are used to measure
the height of the headers, footer and the detail sections.

The Expand/Collapse button is used to expand or collapse the report parts(headers, footers, etc). When
a part is initially in the expanded state click the [button icon] button to collapse it. Then the part get
collapsed and you will not be able to work in it. Then if you click the [button icon] button to expand
it the parts will get expanded and you can continue working on it.

The markers on the horizontal and vertical rulers are used to insert guidelines. To insert your own
guideline, simply click in the horizontal or vertical ruler - a red triangle will appear. To align the fields,
drag them to the guidelines. The benefit of using guidelines is that you can move the guideline markers
on the ruler and all the elements currently snapped to the guideline will automatically move. For
Instance, if you place a horizontal guideline in the report header then drag all the column heading
labels to the guideline, you can then reposition the guideline marker to automatically move all the
column headings up or down. This saves you from selecting and moving each of the column heading
labels manually. .

When the markers are no longer required then they can be removed by opening the marker popup
menu and choosing "Remove" or by dragging them to the edge of the report layout.
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Report parts

The illustration shown in Figure 3.11, “Sample Layout” depicts a typical layout. Although the particular
arrangement of these parts will vary depending on the report type and style you have selected, the part
themselves remain constant and can be manipulated in a variety of ways.

The page header typically contains information relevant to the particular page viewed. The page header
might contain the page number, column headings, border lines or a bitmap. The text and data of this
page is automatically printed after the top margin of every page.

The page footer probably contain information relevant to that particular page viewed and appears at
the bottom of every page. It may be used to print the page total or other pertinent text. Page headers
and footers can contain static content, but they are more commonly used to display varying content
like page numbers or information about the contents of a page.

The section header contains information of the section which will be displayed at the beginning of
each section and footer contains information of section and is displayed at the end of each section in
the report.

Figure 3.11. Sample Layout

Group header present information about the particular data group being viewed - for instance the group
name and a brief description about the data contained in the group and appears at the beginning of a
new group of record. Group footers might contain totals or other similar information that appears at
the end of each group. Group headers and footers can be added by turning on the corresponding check
box when adding the group column in the Group and Sort tab of the Section.

The Detail section contains the main body of the report's data. The detail section prints individual
records, and repeats until all records have been printed. You may expand the Detail section to place
multiple fields above or below each other.

Field labels name specifies fields displayed in the report. By default Elixir Report Designer uses the
field names from the original data source as the field labels in the report, but you can edit the field
labels as needed.

Fields are items of data, from the data source specified in your report.

Data|Shapes|Styles tree panel
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This panel consists of the the Data tab, Shapes tab and Styles tab.

The Data tab contains the tree view representation of the DataSources that this report references. A
new datasource can simply be added under Data tab by drag and drop from Elixir Repository to Data
tab. The DataSource �elds can be directly selected from the Data tab and placed inside the report
layout. The popup menu provides a Refresh option to update the tree if the datasource structure has
changed.

The Shapes tab contains the tree view representation of the report parts and the type and names of the
�elds placed in the layout headers, footers, etc.

The Styles tab contains the tree view representation of the styles of the report parts, fonts, �elds placed
in the group header, group footer and section label etc. Styles can be added to adjust the report outlook
and alignment etc.

Properties Table

The Properties table contains the Name and the Property column. The property name and the corres-
ponding values are listed in the Properties table. When a part of the report or the �eld placed in the
layout is selected then the corresponding properties are listed in the table.
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